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About NCR Aloha RAL 
About NCR Aloha RAL

Formerly Radiant Auto Loader, NCR Aloha® RAL is one of the modules in the Aloha Support Ready suite
of technical support tools. RAL provides a simple way of replacing existing POS terminals and Aloha
Kitchen devices and eases mass deployment of both.

RAL consists of three components:

Aloha Admin Service Located on the Aloha Back-of-House (BOH) file server, the Aloha Admin service
determines and communicates the configuration of the Aloha network. This service scans for RAL client
applications attempting to connect, and passes the necessary information for a terminal become to part
of the Aloha network.

Terminal Configuration Utility Also located on the Aloha BOH file server running the Aloha Admin
Service, the Terminal Configuration utility (Aloha Admin service user interface) allows you to customize
the configuration of each terminal.

RAL Aloha Admin Application Located on each Aloha Front-of-House (FOH) terminal, the RAL Aloha
Admin application provides communication to the Aloha Admin service on the Aloha BOH file server. The
RAL Aloha Admin can initially connect to the Aloha Admin service without a consistent network configu-
ration. Once connected, the RAL Aloha Admin application provides touch screen prompts to the user
with which to select the correct terminal ID.

NCR Aloha RAL at a Glance

Core Product NCR Aloha RAL
Complementary Products Aloha Quick Service, Aloha Table Service, and Aloha Kitchen
Separate License Required? No
Other References Aloha Quick Service Reference Guide; Aloha Table Service 

Reference Guide; Aloha Kitchen Reference Guide

Figure 1  Aloha POS System with RAL
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Hardware and Software Requirements
• Radiant terminals, NCR terminals, and non-NCR terminals.
• Aloha Table Service or Quick Service, installed on the Aloha BOH file server. Aloha Kitchen 

installed on the BOH file server to configure Aloha Kitchen devices. 
• Windows® XP Embedded, Windows 2003 Server, Windows WES, Windows POS Ready (all ver-

sions), Windows 7, and Windows 2008 Server. 
• Supported on both 32-bit and 64-bit operating systems.
• Microsoft® .NET Framework v2.0 on both BOH server and FOH terminal.
• Network Interface card (NIC) on both Aloha BOH file server and POS terminals. RAL also sup-

ports wireless networking.
• RAL supports Remote File Storage (RFS), with no modifications required to RAL or to the Aloha 

system.
• RAL supports the use of Syncinclusion, a feature used to limit the binaries the system syncs to 

the FOH terminals due to hard drive space limitations. Refer to RKS ID 10247 for more informa-
tion on this feature.

• Open ports 11000, 11001, and 11002 for TCP and UDP on the firewall for each terminal, Aloha 
Kitchen device, and Aloha BOH file server.

Creating Windows User Accounts
The Payment Card Industry Data Security Standards (PCI DSS) v.1.2 states that you must assign a
unique ID to each user with computer access and require them to log in using complex, expiring pass-
words. RAL supports the use of a separate Windows user account and password for each terminal and
kitchen device, which minimizes the effort involved in configuration. RAL also supports using complex
passwords and automatically changing the passwords after a defined number of days. This section dis-
cusses how to create user accounts for use with Aloha, if not already created. We recommend you cre-
ate these user accounts before you install and configure RAL to simplify later steps.
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Creating Windows User Accounts 
To create a unique log in account for each device in the Aloha network:

1. Access Administrative Tools > Computer Management and create a user account for 
each terminal on your network, and a user account for the Aloha services, such as EDCSvr, 
RFSSvr, and CtlSvr, if one does not already exist.

2. Select Password never expires and User cannot change password for each account cre-
ated.

3. Add each user account to the Administrators group.
4. Close the Computer Management screen.
5. Open Windows Explorer. 
6. Locate the Bootdrv share, right click, and select Properties.
7. Select the Sharing tab.
8. Click Advanced Sharing.
9. Click Permissions.
10. Click Add and type the user account for the first terminal. 
11. Click Check Names. The system should find the user account. 
12. Select Full Control.
13. Click OK to add the user account. 
14. Repeat the above steps for each terminal user account, the service user account, and the 

Administrator group.
15. Select the Everyone account.
16. Click Remove.
17. Click OK and exit the folder Properties window.

Figure 2  Example of User Accounts
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Implementing NCR Aloha RAL
This section details the implementation requirements within RAL. If you are an experienced user, refer
to Procedures at a Glance for abbreviated steps. If you prefer more detail, continue reading this docu-
ment. 

Implementing RAL on the BOH File Server
By default, the NCR image build process installs RAL on NCR terminals. You must install RAL on the BOH
file server after installing and configuring the Aloha POS system.

RAL install supports customized installs using a custom configuration file with any name, such as
RAL.config. You can modify this file, using Notepad®, before you install. Unlike earlier versions of RAL,
this file can reside anywhere since you indicate the path to the file when you pass the CONFIG= param-
eter on install. If it is not found, RAL uses the default values in each configuration file to install. More
information on the supported values and a sample configuration file can be found in the Custom Install
section.

You no longer have to uninstall RAL on the server or terminal to upgrade. Simply run RALInstall.exe.
The installer makes a backup of the currently installed xml data and configuration files, uninstalls the
old version, then reinstalls the new version using the xml and configuration files from the prior version.
You will not receive a prompt on the terminal. RAL automatically detects the new version, uninstalls the
old version, installs the new version, then automatically restarts.

Procedures at a Glance:

If you are viewing this document using Adobe Acrobat Reader, click each link for detailed information 
regarding the task. 
1. Install RAL on the Aloha BOH file server.
2. Access the AlohaAdminUI, click BOH Config, and edit options, as necessary. Save and exit.
3. Select a terminal and click Configure. Edit the options, as necessary. Save and exit. Repeat for all 

other terminals and Aloha Kitchen devices.
4. Install RAL on the FOH terminals and Aloha Kitchen devices.
5. Reboot each terminal and Aloha Kitchen device.
6. If multiple terminals or kitchen devices are available for reload, select the appropriate profile for 

each device using the touch screen or kitchen bump bar.

The RAL installer changes with the release of RAL version 14.1. It is necessary to click the red 
X and select the component you want to install, either ‘Server’ or ‘Terminal.’ If you do not 
make a selection, it will install the terminal component only. You must uninstall RAL to change 
from one component to another.

You can also install RAL using a command line with the OPTION= parameter. The two values 
are ‘terminal’ and ‘server.’ Example: RALInstall.exe OPTION=terminal
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Implementing NCR Aloha RAL 
Installing RAL on the BOH File Server
Primary control of RAL is on the Aloha BOH file server. If you are installing RAL for the first time, you
should complete the installation and configuration process on the Aloha BOH file server before moving
to the terminals. The process is straightforward, and follows the procedure outlined in this section. This
section assumes you have met all of the requirements and prerequisites to install RAL.

To install RAL on the Aloha BOH file server:

1. Download the installation file, in zipped file format, from the Aloha Update site to the Aloha 
BOH file server.

2. Extract the contents of the zip file to a folder on your server.
3. Optionally, create a custom configuration file, if you want to use a customized install. See 

Help > Help Topics. See “Installing RAL Using a Command Line” on page 31.
4. Double-click RALInstall.exe to launch the installation program. 
5. Click Install to start the installation.
6. Click Next to continue the installation.
7. Select I accept the terms in the License Agreement, then click Next to continue.

8. Click the Aloha RAL Server drop-down arrow, select Will be installed on the local hard 
drive, then click Next.

9. Click Install to begin the RAL installation process. At the end of the RAL installation process, 
the Setup Complete screen appears.

10. Click Finish.
11. Click Close to exit the RAL Installer wizard. RAL automatically launches.

Before installing RAL on the Aloha BOH file server, you must set your time zone to 
the correct setting for your location.

Figure 3  Install Aloha RAL Server Component
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12. If the Aloha BOH file server has more than one NIC installed and no active network card is set 
to LANA 0, a select NIC screen appears. Select the NIC for the Aloha network from the drop-
down list. 

If you select a NIC with a LANA number other than zero, a message appears, asking you to 
select one of three choices:

• Select Change to change the LANA number of the selected NIC to zero. RAL changes the 
LANA number of the card currently set to zero to the next highest available number, then 
changes the LANA of the selected network card to zero.

• Select Don’t Change, and use the selected NIC without resetting the LANA number. You 
must change the LANA number of the selected network card to zero manually, prior to 
attempting to run the FOH on a terminal.

• Select Cancel to abort NIC configuration. The BOH Configuration screen returns, to allow 
you to select another NIC from that location.

13. When prompted, click the drop-down arrow and select the user account to use for the Aloha 
Admin Server. The Set Windows User Account screen appears.

14. Type the password for the user account you selected for the Aloha Admin Server. 
15. Click OK to complete.

If you select the incorrect NIC, you can change this in the BOH Configuration screen after the 
Site Configuration screen appears.

When you select a NIC, RAL assumes the default user ID and password combination of ‘Aloha’ 
and ‘hello’ is present and active, even though you can remove it later. If this user ID and pass-
word combination is not available, a dialog box appears, requiring you to select an administra-
tor user account from a drop-down list.

Figure 4  Select User Account for Aloha Admin Server

Figure 5  Type Password for User Account
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Implementing NCR Aloha RAL 
Using RAL for Site Configuration
Once you install RAL on the Aloha BOH file server, you must next configure it, in preparation for loading
the terminals. As part of the installation, RAL obtains many of the required settings directly from envi-
ronment variables already configured on the file server.

The RAL menu provides access to the RAL Aloha Admin service, which appears as AlAdmSvr in the list
of services in Administrative Tools. The initial RAL installation process installs and starts the RAL Aloha
Admin service, and configures it to start automatically, so it normally runs at all times. You can select
‘Service’ from the RAL menu to verify the current status of the service, or you can stop, start, or restart
this service directly from the menu.

Accessing RAL from the System Tray

Right click the icon in the system tray (systray) to view the menu options.

Service — Expands out to another submenu that provides the following options:

Start  — Starts the AlAdminSvr service. Appears grayed out if the service is already started.

Stop — Stops the AlAdminSvr service. Appears grayed out if the service is stopped. 

Restart — Restarts the AlAdminSvr service.

Open UI — Opens the RAL user interface to the Site Configuration screen. You can also double-click
the icon to open the user interface.

Show UI — Selected by default, the user interface appears in the taskbar when minimized. If cleared,
the user interface does not appear in the task bar, but the icon appears in the systray if you did not exit
the user interface. Exiting the user interface will completely exit the program. 

Help — Expands another submenu with the following options:

Help Topics — Allows you to view the RAL help file. 

About RAL — Allows you to view the About screen.

Figure 6  About Screen
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Configuring RAL Settings for FOH
After the initial installation, some sites require additional configuration. If your site must join a domain,
or you use Windows log-in accounts (recommended), other than the default NCR accounts, you must
edit the RAL site configuration. You may also need to make other changes on the Aloha BOH file server,
depending on local needs.

The RAL user interface is divided into three main screens:

• Site Configuration screen
• BOH Configuration screen
• Terminal Configuration screen

Accessing the Site Configuration Screen

The Site Configuration screen is the main screen of RAL. All defined terminals, site information, server
name, and the functions to set up the server to prepare for configuration appear on this screen. RAL
auto-populates the Site Configuration screen by default with any order entry terminals defined in \New-
data\Trm.dbf and any Aloha Kitchen devices found in AlohaKitchen.xml. (See “Using RAL on a FOH Ter-
minal to Complete the Configuration” on page 23 for an exception to this rule). Use the button functions
in Site Configuration to open the Terminal Configuration screen and adjust each terminal with specific
settings.

Site — Specifies the unit name as defined in Aloha.ini.

Aloha Server — Specifies the Windows computer name of the Aloha BOH file server.

BOH Config button — Accesses the BOH Configuration screen.

Terminal Copy button — Accesses the Terminal Copy screen. See “Copying Settings from One Termi-
nal to Another” on page 20.

Reset Site — Resets all previous configuration settings for each terminal to the default values. This
button only appears if you set the system environment variable RALResetSite with a value of TRUE on
the server.

Figure 7  Site Configuration Screen
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Implementing NCR Aloha RAL 
Exchange Terminals — Allows you to select two terminals and exchange the number for each termi-
nal to move a terminal to a critical location, such as driving a kitchen printer.

Refresh — Refreshes the RAL user interface screen with the latest configuration information. Do not
confuse this with the Refresh function of the Aloha POS.

Reload/Cancel Reload — Sets the selected terminal for reload or cancels the reload of a terminal set
to reload. If the selected terminal is set for reload, the button label toggles to Cancel Reload. A terminal
reloads the next time RAL starts on that terminal, connects to the Aloha Admin service, and detects it
must reload.

Configure — Accesses the Terminal Configuration screen. If you select a terminal on the Site Configu-
ration screen, it will load the configuration for that terminal. If a terminal is not selected, RAL allows
you to add a new terminal. 

Reload All/Cancel Reload All — Reloads or cancels the reload for all terminals at once. If one or
more terminals is set to reload, the button label toggles to Cancel Reload All.

Delete Terminal — Deletes the selected terminal from this screen and clears all information for the
terminal from the data xml file.

Set Base IP — Allows you to define the IP address RAL uses to base the IP numbering schema for your
terminals. RAL adds to the terminal number to the last octet for consistent numbering. For example, if
you define 100 as the last octet, RAL sets Term1 to 101, Term2 to 102, etc. 

Exit — Closes and exits the Site Configuration screen.

Defining the Network Using the RAL BOH Configuration Screen

Use the RAL BOH Configuration screen to define or change global terminal settings, such as:

• Defining the Windows user account to allow terminals to join a domain.
• Defining the EDC path.
• Defining the Windows user account the terminals use to connect to the EDC and Control ser-

vices on the Aloha BOH file server.
• Defining the Windows user account the terminals use to log in.
• Removing default Windows user accounts.

Select F1 from this screen to call the RAL Help file.
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• Defining password change management rules.
• Changing the NIC used by RAL and Aloha on the BOH file server.

On the Site Configuration screen, click BOH Config to access the RAL BOH Configuration 
screen.

Defining the Server Name

Allows you to change the computer name in system properties from the RAL BOH Configuration screen.
Most sites do not use this feature.

To change the computer name:

1. In ‘Aloha Admin Server Name,’ click Change. The Aloha Admin Server Name screen appears.
2. Type the new computer name, then click OK.
3. Reboot the Aloha BOH file server.
4. Change the SERVER variable value in system environment variables to match the new com-

puter name then start the user interface.

Defining Domain Account Information

If your Aloha BOH file server and terminals belong to a domain, you must use the following option to
allow the terminals to join the domain.

To define domain credentials:

1. In ‘Domain Account Info,’ click Change. A dialog appears to enter the user name and password 
for the domain.

2. Type the name of the user with rights to join a terminal to a domain in ‘Domain Admin ID.’ This 
account is not the same as local Admin rights. Check with your network administrator for the 
correct user account.

3. Type the password for the domain user account in ‘Domain Admin Password.’ The password 
appears as a series of dots when entered.

Figure 8  RAL BOH Configuration Screen
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Implementing NCR Aloha RAL 
Defining the Path to the EDC Server

Use this option if you use an EDC server that is not the same server as the BOH file server. By default,
RAL uses the SERVER variable on the file server to populate the server name here. 

To define the EDC path:

1. Type the network path to the EDC server in ‘EDC Path.’
2. Click Save.

Defining the EDC/RFS User Account

If you use EDC or RFS, you must define the user account for the system to use when accessing these
services. When defined, RAL creates this account on each terminal to access these services on the
Aloha BOH file server.

To select the EDC/RFS user account:

1. Select the account defined for the EDC/RFS Services on the BOH from the ‘User’ drop-down 
list.

2. Type the password for the selected account.

Managing the Administrator Windows User Account on Terminals

This section discusses managing preconfigured user accounts and rotating the password of the Admin-
istrator account on each terminal.

To define the Windows user account used by the terminal:

1. In ‘Windows User Account,’ leave the Windows Account ID as default.

2. Select Remove Preconfigured User Accounts. This removes any NCR factory user accounts, 
such as Aloha and User01, from each terminal.

3. Click Change Administrator Password for All Terminals to change the built-in administra-
tor account password on all terminals configured by RAL.

4. Select Automatically change local Windows Password after x Days to automatically 
change the password of the Administrator account of each terminal periodically.

5. Accept the default value of 90 days or adjust to a lower number of days. RAL enforces a max-
imum of 90 days in accordance with PCI guidelines.

6. Select the time of day at which RAL automatically changes the password. 

The Reset button will set the EDC Path back to the default value.

This functionality is obsolete. There is no need to click Change User or Update Password. Edit-
ing these options has does not affect RAL functionality.

The password change must occur within a short time of the system changing the password on 
the BOH file server. Terminals log off or reboot after an EOD, therefore; we recommend you 
set the time to change the password to at least one minute before you run EOD.
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Defining the Network Interface Card

The ‘Network Interface Card’ drop-down list provides a list of all NICs installed on the Aloha BOH file
server. By default, RAL lists the NIC associated with LANA 0 for use with the Aloha system. If only one
NIC exists on the file server, this box appears dimmed and RAL defaults to use this NIC.

To select another NIC to use with the Aloha POS system: 

1. Select a NIC from the ‘Network Interface Card’ drop-down list. RAL prompts you to set the 
LANA number to zero. 

2. Select Yes to change the LANA number to zero and allow the Aloha system to communicate 
over the selected NIC. 

Enabling DHCP

Select ‘Enable DHCP,’ if you do not use static IP addresses for your terminals and have a DHCP server to
assign IP addresses. RAL does not validate if there is a DHCP server. You must configure a DHCP server
for the terminal to get an IP, DNS, and Gateway address.

Allowing Your Terminals Access to the Internet

If your terminals require access to the Internet for training or third-party applications, you must config-
ure the DNS addresses and gateway for your network.

To configure access to the Internet for terminals:

1. Type the IP address for the first DNS server in ‘DNS1.’
2. Type the IP address for the second DNS server in ‘DNS2.’
3. Type the IP address for the gateway on your network that provides access to the Internet in 

‘Gateway.’

Saving Your Changes

After you define your configuration in the RAL BOH Configuration screen:

• Click Save to update the system with the changes.
• Click Cancel to return to the Site Configuration screen without saving changes.
• Click Exit to exit the BOH Configuration screen. RAL prompts to save changes. Click Yes or No 

to save any changes.

The system will not populate the gateway, DNS1, and DNS2 entries on the terminal, even if 
you set them up in the user interface, unless you also use the following key in AlhAd-
min.exe.config on the terminal before the initial configuration.
<add key="SetGatewayInfo" value="1"/>
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Implementing NCR Aloha RAL 
Configuring Terminals
Use the Terminal Configuration screen to define terminal specific settings, such as the Windows user
account the terminal uses to log on, IP configuration, and to enable Order Point. 

To access the Terminal Configuration screen:

• From the Site Configuration screen, click Configure, without a terminal selected, to configure a 
new terminal.

-OR-

• Select a terminal, and click Configure to view the configuration for the selected terminal.

To configure a terminal:

1. Select either TableService or QuickService in ‘Aloha Installation Type.’ By default, RAL auto 
selects the proper setting based on the presence of a “Fastfood” flag file in the %Iberdir% on 
the Aloha BOH file server. If found, RAL automatically selects ‘QuickService.’ Conversely, if the 
file is not found, RAL automatically selects ‘TableService.’ 

By default, RAL selects ‘Kitchen’ if the device is found in the AlohaKitchen.xml file.

2. Select Master Capable if the terminal has enough resources to perform the master role in the 
Aloha POS system and you would like the terminal to become master, if necessary.

3. Select Server Capable if the terminal has enough resources to perform as a redundant server, 
if necessary. By default, the system selects ‘Master Capable’ when you select ‘Server Capable.’

4. Clear Double Click unless you use a mouse with the terminal. This prevents undesired double 
button touches when you access the POS on the terminal. Select Double Click, if you use a 
mouse on the terminal with other applications and to set the environment variable DOUBLE-
CLICK=TRUE.

5. Select Create BOOTDRV Share to create the share used by the Aloha POS system to 
exchange files between terminals and the Aloha BOH file server. 

Figure 9  Terminal Configuration Screen
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6. Select the desired behavior for a terminal when Aloha exits due to a refresh or EOD.

• Exit to Desktop — Exits to the Windows desktop after a refresh or EOD (not recom-
mended). This option is the same as using the environment variables AUTOEXIT=FALSE 
and REBOOTNT=FALSE.

• Log off Current User — Logs the current user off after a refresh or EOD. This option is the 
same as using the environment variables AUTOEXIT=TRUE and REBOOTNT=FALSE.

• Reboot Computer — Restarts the terminal after a refresh or EOD. The terminal logs back 
on with auto-login settings. This option is the same as using the environment variables 
AUTOEXIT=TRUE and REBOOTNT=TRUE.

7. Select the user account the terminal uses to log on. We recommend selecting a unique 
account for each terminal, as defined in “Creating Windows User Accounts” on page 6.

8. Type the password for the selected user account in ‘User Password.’
9. In ‘Confirmation Display,’ select Use OrderPoint if the terminal has an attached customer dis-

play.

10. Select Enable Radiant Video, if this terminal controls Radiant video devices. Type the ID 
number of each display in use in the ‘IDs’ text box, using commas to separate multiple Radiant 
video devices. This option is not available for Aloha Kitchen devices.

11. Type the path where RAL installs Aloha on the terminal in ‘Aloha Path.’ The default is C:\Boot-
drv\%Iberroot%. 

For Aloha Kitchen, it defaults to C:\Bootdrv\AlohaKitchen.

12. Type the path where the calibration program is located in ‘Path to Calibrate EXE.’ The drop-
down list allows you to select a terminal type. RAL auto-populates ‘Path to Calibrate EXE’ with 
the correct setting when you use this drop-down list.

13. (Optional) In ‘Batch File,’ type the drive letter, path, and file name of a batch file to run, 
when RAL reloads or runs on the initial configuration. RAL runs the batch file before it calls Iber-
cfg.bat file on the terminal. Enclose the string in double quotes if it contains spaces. 

You can click Browse to select the drive, path, and file for automatic insertion in this text box.

Select Run Each Reload to run the batch file each time the terminal reloads. We recommend 
you save the batch file to %Iberdir%\EXTData\RAL on the Aloha BOH file server, since this 
directory is already shared.

14. If necessary, adjust the Starting IP Address of the terminal to meet your needs. All fields are 
editable, effective with RAL 14.1, including the subnet mask. By default, RAL sets the last octet 
of the first terminal as 101. You can change this by:

• Manually changing the IP address on this screen.
• Clicking Set BaseIP on the Site Configuration screen.
• Using Notepad to open AlAdmSvr.exe.config file and type 1 for the ‘UseServerIP4thOctet’ 

key value, to set the Base IP to start one number higher than the last octet of the server.

15. If you are not using fixed IP addresses in your site, select DHCP. ‘Starting IP Address’ becomes 
unavailable. The terminal obtains its IP address from a DHCP server each time it restarts.

‘Uses OrderPoint’ is not available for selection if Order Point is not installed on the Aloha BOH 
file server or Kitchen is selected as the device type.

TermStr is hard coded and pulled from the TERMSTR system environment variable on the 
Aloha BOH file server. If this does not exist on the server, an error message appears stating 
the variable is missing and RAL exits the Terminal Configuration screen.
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Implementing NCR Aloha RAL 
16. In most cases, we recommend you accept the default values to allow the terminals to connect 
to your network. RAL auto-populates ‘Domain/Workgroup Details,’ based on the network config-
uration of the Aloha BOH file server. You can define the RALWORKGROUP system environment 
variable on the server to have RAL bypass this option.

17. Type additional custom lines to add to the Ibercfg.bat file in any of the four ‘Command Line’ 
boxes and select if you want the command to run before Iber. This allows you to define any 
variable that is not already defined either in system environment variables or through the use 
of specific flags, such as ‘Use Radiant Video’ or ‘Uses OrderPoint.’ You can enter more than one 
command on each line but you must separate the commands using the following syntax: 
amp&;.

This option is not available when the selected device type is Kitchen. When RAL configures a 
terminal, the only lines in this batch file, by default, are:

• A command to copy files from Newbin to Bin.
• A command to delete the contents of Newbin.
• A command line to start the FOH.

Select Run Before Iber for each command line you want RAL to insert in Ibercfg.bat prior to 
the line that launches Iber(QS). Do not include environment variables in Ibercfg.bat, as RAL 
adds these to the environment during configuration. Add lines to Ibercfg.bat to run external 
applications, such as QSR.

18. Click Save, then Exit to return to the Site Configuration screen.
19. Repeat these steps for each terminal, using a different account for each terminal.

Configuring Aloha Kitchen Devices in RAL
RAL queries the AlohaKitchen\Data folder for AlohaKitchen.xml to populate the RAL user interface with
kitchen devices to configure.

RAL creates the following system environment variables on a kitchen device as part of configuration:

• IBERROOT
• CALIBRATE
• SERVER
• TRMSTR
• RALEXE

The path to RALEXE is set to the same location as AlhAdmin.exe. Do not delete or edit this variable or
its associated value. The system needs this variable to start RAL after EOD or a refresh on the kitchen
devices.

RAL creates an AKStart.bat file, which looks similar to the following: (KPSController, Termstr, Iberroot,
and POSServer will all match your system and setup).

SET KPSCONTROLLER=81
SET TERMSTR=TERM
SET KITCHENFOLDER=C:\BootDrv\AlohaKitchen
SET IBERROOT=Aloha
SET POSSERVER=ALOHABOH
NET TIME \\%POSSERVER% /SET /Y
COPY %KITCHENFOLDER%\NEWBIN\*.* %KITCHENFOLDER%\BIN\ /Y
DEL %KITCHENFOLDER%\NEWBIN\*.* /Q
START /WAIT %KITCHENFOLDER%\BIN\ALOHAKITCHEN.EXE /CONTROLLER %KPSCONTROLLER%
CALL "%RALEXE%"
EXIT
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Copying Settings from One Terminal to Another
The Terminal Configuration Copy screen is available in RAL versions 2.3.2.14 or later. This screen allows
you to set specific settings in the configuration on one terminal and copy the settings to another termi-
nal, a range of terminals, or all terminals, saving you time and effort.

To copy the configuration of a terminal:

1. Click Terminal Copy on the Site Configuration screen.

2. In ‘Source Terminal,’ select the terminal from which to copy the configuration from the drop-
down list.

3. In ‘Destination Terminal(s),’ select All the rest of the terminals to copy the configuration to 
all other terminals. 

-OR-

Select a specific terminal or a range of terminals using the ‘Copy to terminal beginning 
from’ and ‘Copy to terminal ending with’ drop-down lists.

Figure 10  Terminal Copy Screen
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4. In ‘Items to copy from Source Terminal to Destination Terminal(s),’ click Toggle All Options to 
select or clear all options. Clear or select individual options, as necessary.

5. Click Save.

Restricting User Account Login on the BOH
Once you define the Aloha service and terminal user accounts in the FOH Configuration screen, we rec-
ommend you restrict the ability of someone using one of these user accounts to log in to the Aloha BOH
file server.

To prevent a user account from being used:

1. Select Start > Run and type gpedit.msc. The Local Group Policy Editor screen appears.
2. Select Computer Configuration > Windows Settings > Security Settings > Local Poli-

cies > User Rights Assignments, then double-click Deny log on locally.
3. On the Local Security Setting tab, click Add User or Group.
4. Type each user account you created for the Aloha service and terminals.
5. Click Apply, click OK, and exit the Local Group Policy Editor.
6. On the Bootdrv share, remove Everyone and add each terminal and the services account 

from the permissions.

Installing RAL on a FOH Terminal or Kitchen Device
NCR terminals ship with RAL installed and ready to run. If you have an older or a non-NCR terminal
without RAL installed, you must install RAL manually. Use the following procedure to install RAL on a
terminal.

To install RAL on a terminal:

1. Use a portable memory device, such as a USB flash drive, LAN, or other means, to copy 
RALInstall.exe to the terminal.

2. Locate and launch RALInstall.exe on the terminal to begin the RAL installation.
3. Click Install, in a typical installation, to skip to the next step, and complete the installation.
4. Click Next to continue the installation.

Aloha Kitchen devices ignore most of the check boxes since they are not used for configura-
tion.

The copy function only works for like terminals. For example, if the source device you select is 
a POS terminal, you can only copy to POS terminals, not Aloha Kitchen devices. The same 
holds true if the source is a kitchen device, it can only copy to like Aloha Kitchen devices.

You must reverse this procedure, if you change the password for a terminal using the Terminal 
Configuration screen. When changing passwords on this screen, RAL attempts to log in the 
user account. If you include the user account in the ‘Deny log on locally’ group, RAL fails the 
change password function.

If RAL is already installed on the terminal it will upgrade to the server version automatically, if 
using version 2.3.2.10, or later, on the terminal.
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5. Select I accept the terms in the License Agreement, then click Next to continue.

6. Click the Aloha RAL Terminal drop-down arrow, select Will be installed on the local hard 
drive, and click Next.

7. Click Install to begin the RAL installation process. At the end of the RAL installation process, 
the Setup Complete screen appears.

8. Click Finish.
9. Click Close to exit the RAL Installer wizard and return to the desktop.

10. Click Start > All Programs > Startup > Aloha Terminal Configuration to launch RAL and 
configure the terminal.

Figure 11  Installing the Aloha RAL Terminal Component

In RAL 14.1 versions, the installer cannot auto detect if the machine is a Radiant POS termi-
nal. It will always default to no component being installed and will require you to define the 
proper component to install or use the command line option below to force the installer to use 
the component of your choosing.

By default, RAL version 2.3.2.18 currently ships on all NCR terminals preinstalled and the 
installer and RALInstall.exe.config file reside in the C:\Staging folder on all terminals. Aloha 
Kitchen devices will ship with RAL version 3.0.3.168.
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Using RAL on a FOH Terminal to Complete the 
Configuration
When you add a new Aloha terminal or Aloha Kitchen device (with RAL installed) to the network, the
RAL client uses User Datagram Protocol (UDP) calls to the server to detect the configuration settings
and configure the terminal.

The RAL client runs on the terminal at startup. Each time the terminal starts, RAL checks for the reload
marker on the BOH file server, as it loads. 

• If the RAL client detects the reload marker for the terminal, RAL discards the current terminal 
configuration, and reloads the terminal. 

• If this is the initial configuration or you select Reset Terminal on the terminal, RAL prompts you 
to select the terminal number, if more than one terminal is available for reload.

If only one terminal is available, RAL automatically selects this terminal and continues with the 
configuration.

• If the terminal is an existing, functioning Aloha terminal, and the terminal is not marked for 
reload, RAL starts the terminal normally.

• If there is a Reload marker on the BOH for the terminal and you did not select Reset Terminal, 
RAL will simply do a partial configuration on the FOH terminal, meaning it will only make the 
changes necessary and restart the terminal, if necessary.

• If the RAL client detects a difference between the version of RAL installed on the terminal and 
the version installed on the BOH file server, the BOH file server receives notification from the 
terminal, and propagates its version to the terminal. In this manner, RAL maintains version 
synchronization between the BOH file server and the terminals in the network.

When you make changes to your restaurant that impact the number of terminals in your system, you
must change the NUMTERMS variable to reflect the number of terminals in use after the change. If for
any reason, a mismatch develops between the NUMTERMS variable and the number of terminals actu-
ally in use on your network, a message to this effect appears on the Aloha BOH file server, asking you
to make this correction. 

To change the NUMTERMS variable:

1. Access Environment Variables on the Aloha BOH file server and adjust the NUMTERMS vari-
able, as necessary. 

2. Restart the AlAdmSvr service to detect this change. RAL marks all terminals for reload. 
3. After you restart each terminal, the Select Terminal screen appears. You must go to each termi-

nal, in turn, and select the terminal number for each one. Each terminal begins reloading 
when you touch its number. 

Selecting the Network Interface Card on the FOH
When you connect a new terminal to the Aloha network and power it up, the Aloha system is not part of
the installed software load on the terminal. The RAL client application, installed on the terminal during
manufacture, works with the Aloha BOH file server to accomplish this installation. Depending on the
terminal you are installing, more than one NIC may be part of the hardware suite. Although the system
configures only one NIC with its LANA number set to zero (0), all NICs installed during manufacture are
active and ready for use.
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If the FOH terminal has more than one NIC, select the appropriate NIC to use for the Aloha network.

When RAL loads on the terminal for the first time, it checks the terminal for all installed NICs, and asks
you to select the card you want to use if it finds multiple NICs. By default, RAL places focus on the card
with its LANA number already set to zero, but allows you the opportunity to select another card. RAL
displays a 30-second countdown timer, giving you the opportunity to select a different NIC. If RAL does
not receive input within 30 seconds, it binds to the NIC selected by default. If you select the other NIC,
RAL changes its LANA number to zero, and binds to it, prior to restarting.

If you configure the terminal to use the wireless NIC from the start, and experience difficul-
ties, you can: 

1. Connect a network cable to the terminal.
2. Select the terminal on the Site Configuration screen and click Reload.
3. Click Aloha Reset Terminal the desktop of the terminal and allow the terminal to restart.
4. When the NIC selection screen appears, select the NIC to which you connected the network 

cable. Allow RAL to continue the configuration and select the terminal, as necessary.
5. If RAL successfully configures the terminal using the wired network cable, correct the wireless 

network settings. Repeat steps 1 - 4, selecting the wireless NIC on step 4 to attempt to 
connect using the wireless NIC.

Selecting the Device Type
If you select multiple terminals or kitchen devices for reload, the Select Terminal screen appears on
each device, prompting you to select the terminal type to install, either POS or Kitchen. As in NIC card
selection, RAL displays a 30-second countdown timer, with the first device in the list selected. If RAL

Figure 12  Multiple NIC Selection Screen
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does not receive input within 30 seconds, it configures the device per the default selection. If only one
terminal is marked for reload, this screen does not appear and RAL automatically reloads the available
terminal. The countdown timer does not appear on initial configuration of a terminal.

The terminal restarts, after completing the reload. The floating logo screen appears when the terminal
is ready for use as a POS terminal and Aloha Kitchen screen loads for kitchen devices.

If you run Reset Terminal on the FOH after RAL configures the terminal, the 30-second timer does not
appear. Using the Reset Terminal button is basically resetting the terminal configuration settings as
though the terminal just came out of the box.

If you have both POS terminal and Aloha Kitchen devices, the Select Aloha Terminal Type screen
appears.

This timer is configurable from AlhAdmin.exe.config using the ‘DefaultTermSelTime’ key. 

Figure 13  Terminal Type Selection Screen
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Select POS or Kitchen, based on the role of the terminal. Your selection determines which
Select Aloha Terminal id screen appears. 

To select a terminal:

• Touch one of the available terminals on the Select Aloha Terminal ID screen.

-OR-

Touch Go Back to return to the Terminal Type selection screen, if you touched the wrong but-
ton.

Figure 14  Select Aloha Terminal Screen

Figure 15  Select Aloha Kitchen Device Screen
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To select an Aloha Kitchen Device:

Touch one of the available kitchen devices on the Select Aloha Terminal ID screen.

-OR-

Touch Go Back to return to the Terminal Type selection screen, if you touched the wrong button

To use a bump bar to select a kitchen device:

If the kitchen device does not use a touch screen or has a bump bar attached, you can use the bump
bar to select the Aloha Kitchen terminal profile.

1. On the 16-key bump bar, use any of the buttons between the large left and right arrow buttons 
to tab between the terminal selection buttons on the screen.

2. Press the left or right button to load the terminal using the selected profile.

Figure 16  16-key Bump Bar

Tab between terminal
profiles

Reload selected 
terminal

Reload selected 
terminal
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Discussing Using Separate User Accounts on a 
Terminal
This section discusses how RAL configures accounts on each terminal when you define a separate user
account for each terminal. 

When RAL configures a terminal, it:

• Adds the user account used by a terminal to log in.

• Sets the account to automatically log on.
• Encrypts and hides the auto-logon account password in the registry.

• Adds the EDC/RFS services account and each terminal user account that is not the login 
account for that terminal to the ‘Deny local log on’ policy on the terminal, similar to how you 
configured the accounts on the Aloha BOH file server. 

• Removes EVERYONE from the Bootdrv share and adds the EDC/RFS services account and each 
terminal account to the share permissions with full access.

• Disables the Administrator account on each terminal. Use the following key in the AlhAd-
min.exe.config file:
<add key=“DisableAdmin" value=“1" />

Figure 17  Example of User Accounts on a Three Terminal System
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Upgrading RAL
Upgrading RAL is a fairly simple process, but it can involve connecting a keyboard to each terminal, in
turn, which can be very time-consuming, especially for sites with a large number of terminals. In addi-
tion, manual processes are subject to error. This section discusses the RAL upgrade process, including a
method for accomplishing the upgrade without connecting a keyboard to each terminal, thus potentially
saving you considerable time.

The first step in upgrading RAL is to install the new version on the FOH terminals. After accomplishing
this, you can then install it on the BOH file server without finding yourself unable to reload a terminal.

If you follow this procedure, the terminals will still run, as the newer versions of RAL are backward com-
patible, but use only the functions active in the version on the file server, if it is older.

If you install different versions of RAL on the file server and the terminals, the results vary, depending
on the versions involved. The following table discusses the actions you may need to take in response to
specific version mismatches between servers and terminals.

When you upgrade the file server to v14.1.4.1 or later, RAL marks all terminals for a reload, so that the
terminals receive the same version. When later versions of RAL become available, you only need to
upgrade the file server. It automatically marks the terminals for a reload, and upgrades them as part of
that process.

NCR currently ships terminals with RAL version 2.3.2.18. RAL is not installed on the file server 
due to the requirement that Aloha be installed. The install package can be found in C:\Staging 
folder on all terminal images and D:\Staging\RAL on all server images.

Server Version Terminal Version Result Upgrade Required

2.3.2.21 or lower 14.1.4.0 or later RAL does not run on the ter-
minal. It drops to the desktop 
by design. The log file shows 
the following message: Server 
response was null, possible 
version mismatch. Verify that 
RAL Server version is equal or 
later than RAL Terminal.

Must upgrade server to 
3.0.0.0 or later version.

14.1.4.x 14.1.4.x Normal configuration. No upgrade occurs on 
the terminal if the last 
digit in the build installed 
on the server matches 
the last digit in the build 
installed on the terminal.

14.1.4.x 2.3.2.10 to 14.1.4.x Normal configuration then the 
terminal upgrades to the 
14.1.4.x version.

Upgrade is automatic on 
the terminal.

14.1.4.x 2.3.2.9 and earlier. Upgrade fails due to a defect 
in version 2.3.2.9 and earlier.

Must manually upgrade 
the terminal.

During the upgrade process on the terminal, it appears that the terminal is not responding 
and at the desktop. RAL is in fact removing the old version and installing the new version 
using the /quiet parameter. It generally takes 2 to 3 minutes after the first RAL reboot for the 
new interface to appear and configure Aloha.
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Using Custom Configurations with RAL
Use the following sections to customize your RAL installation and environment. Topics include:

• Using RAL on a FOH/BOH computer.
• Changing the password length with RAL.
• Installing RAL using a command line.
• Running more than one RAL service on a network.
• Translating RAL.

Using RAL on a FOH/BOH Computer
You can install RAL on a terminal in such a way that you can use the terminal as both a FOH/BOH
machine and have the terminal act as the file server component.

To configure a FOH/BOH computer for RAL:

1. Locate the RALInstall.exe.config file and use Notepad® to open the file. By default, RAL 
installs to the C:\Program Files\Aloha SupportReady\Aloha Admin Service directory.

2. Add the following line to the RALInstall.exe.config file:
<add key="RALServer" value="1" />

3. On the toolbar, click File > Save.

This automatically installs the BOH file server component on the terminal instead of installing the POS
terminal component.

RAL cannot act as both the server component and the POS terminal component on the same 
machine. If you install RAL using this key variable, you only get the server component.

You must install Aloha on the terminal and select ‘Run FOH/BOH on same machine.’

The terminal number to which you assign the FOH/BOH machine does not appear in the RAL user 
interface, since RAL cannot confirm the RAL server machine.
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Changing the Administrator Password Length with 
RAL
RAL allows you to define the number of days at which it automatically changes the password for the
‘Administrator’ user account on each terminal, to comply with PCI-DSS requirements. This feature is
also supported on Aloha Kitchen devices. See “Managing the Administrator Windows User Account on
Terminals” on page 15.

When the password changes:

• RAL changes the Administrator windows user account password on each terminal.
• RAL does not change the EDC/RFS user account password unless it is shared with either a ter-

minal or is the same account being used as the Administrator user account. 
• The default number of characters for the new password is eight, unless you edit the value of 

this key.

To change the number of password characters:

1. On the Aloha BOH file server, use Notepad to open C:\Program Files\Aloha Suppor-
tReady\Aloha Admin Service\AlAdmSvr.exe.config.

2. Locate <add key=“PasswordStrength" value=“8" /> and change the value of the key to 
any number equal to or greater than the current value defined on the account policy (Minimum 
Password Length).

3. Stop, then restart, the AlAdmSvr service after you make this change.

Installing RAL Using a Command Line
RAL version 14.1.x supports the installation of RAL using a command line. The following parameters
are:

/quiet  — Installs RAL either on the terminal or Aloha BOH file server without user intervention. You
must use one of the following two parameters in conjunction with this one. 

• OPTION=server
• OPTION=terminal

If you use ‘server,’ RAL installs the BOH component on the machine. The ‘terminal’ value installs the
terminal component. 

To use a custom install to add variables to one of the three configuration files that RAL uses, you have
to pass the following variable and value:

• CONFIG=<path and name of configuration file>

You must pass the OPTION and CONFIG variables in all CAPS; however, the value 
can be lowercase. If either parameter is in lowercase, the installer will ignore it.
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Sample Installation Configuration File
<?xml version="1.0" encoding="utf-8" ?>
<configuration>
<appSettings>
<!-- add key="TermUI" value="TermUI" /-->
<!-- add key="Service" value="Service" /-->
<!-- add key="AdminUI" value="AdminUI" /-->
<!-- add key="TermUI.CopyRemotely" value="0" /-->
<add key="Service.BaseLocalDir" value="C:\Bootdrv\" />
<add key="Service.BeforeIberCfg1" value="SET TEST" />
<add key="AdminUI.ShowSplashScreen" value="1" />
<add key="AdminUI.ValidateUser" value="0" />
<add key="TermUI.SetGatewayInfo" value="0" />
/appSettings>
</configuration>

• You can find the variables used in the configuration file in Help > Help Topics from the task bar 
icon.

• You must preface all keys that are written to the service configuration file (AlAdmSvr.exe.con-
fig) with ‘”Service.,” as shown above.

• You must preface all keys that are written to the BOH user interface configuration file (AlAdS-
vrUI.exe.config) with “AdminUI.,” as shown above.

• You must preface all keys that are written to the terminal configuration file (AlhAdmin.exe.con-
fig) with “TermUI.,” as shown above.

• You can install all of the above configuration using a batch file. The following is an example 
batch file command line to install RAL on the server using a custom configuration is shown 
below:
ralsetup.exe /quiet OPTION=server CONFIG=D:\RALInstall.exe.config

Running More Than One RAL Service on a Network
Use Store.xml when you have more than one server running the RAL service on your network switch.
Though this configuration is not common, it has been used on some live sites and is useful in lab envi-
ronments where you may have two servers, such as one for QS and one for TS on the same network.
The structure of Store.xml appears below and can contain many stores. This example is a two store
setup.

<?xml version="1.0" standalone="yes"?>
<AllStoreInfo xmlns="http://tempuri.org/AllStoreInfo.xsd">
  <Store>
    <Id>1</Id>
    <StoreId>1</StoreId>
    <StoreName>TS Store</StoreName>
  </Store>
  <Store>
    <Id>2</Id>
    <StoreId>2</StoreId>
    <StoreName>QS Store</StoreName>
  </Store>
</AllStoreInfo>
\
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You must copy Store.xml to the following locations:

Since RAL uses UDP, it must either be on a different network or communicate using different port num-
bers. You can manually edit the port numbers in the configuration files, but the use of Store.xml elimi-
nates the need to edit these files. Once selected, RAL uses a base of five to determine the ports on
which to listen and send. It multiplies the store number by five to determine the port numbers. 

For example, if you select Store 1, it will communicate on ports 11005, 11006, and 11007. Store 2 will
communicate on ports 11010, 11011, and 11012.

When RAL starts on a FOH terminal, the Store Selection screen appears as shown in Figure 18. Touch
the drop-down list, containing all of the stores defined in Store.xml, and select the store to which to
connect the terminal.

Server= C:\Program Files\Aloha SupportReady\Aloha Admin Service folder. (32 bit)
C:\Program Files(x86)\Aloha SupportReady\Aloha Admin Service folder. (64 bit)

Terminal= C:\Program Files\Aloha SupportReady\AlohaAdm folder.

Table 1: Example of Ports with Multiple Stores

Port Default Store 1 Store 2

MulticastUDPSendPort 11001 11005 11010
MulticastUDPListenPort 11002 11006 11011
RemoteCopyPort 11003 11007 11012

Figure 18  Store Selection Screen
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Translating RAL
The Resource folder contains Strings.txt, which stores all of the label information for the RAL user inter-
face. This file is read-only, but you can change the file properties to allow you to edit any label within
the RAL user interface to a new language, if needed.

To change this, use the following procedure:

1. Stop the AlAdmSvr service.
2. Access C:\Program Files\Aloha SupportReady\Aloha Admin Service\Resources.
3. Right-click Strings.resources and Strings.txt, select Properties, and clear Read only. 
4. Open Strings.txt using Notepad.
5. Translate the text to the right of the equal sign to the desired language or operational term. 

Use the \n to move the text to the next line.

Example: If you want to translate the Refresh button to Spanish:

Change btnRefresh=Refresh to btnRefresh=Refrescar

Example: If you want to change the Refresh button to say Refresh Screen,
with Screen on the second line:

Change btnRefresh=Refresh to btnRefresh=Refresh\nScreen

6. Save Strings.txt.
7. Right-click Start > All Programs > Accessories > Command Prompt and select Run as 

administrator. 
8. Change the directory to C:\Program Files\Aloha SupportReady\Aloha Admin Ser-

vice\resources.
9. Type in the following command:

resgen.exe strings.txt strings.resource
10. Press Enter. You should get the following message, if successful:

Read in 110 resources from 'strings.txt'
Writing resource file... Done.NCR RAL v14.1 FFG

11. Change the properties for each file back to ‘Read only,’ if successful.

On the desktop, double-click the Aloha Service Admin user interface icon. If successful, the RAL
icon appears in the systray and you can open the user interface with your changes.

Make a backup copy of Stings.txt and Strings.resources before beginning.

Make changes only to the text on the right side of the equal (=) sign.
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General Info
RAL Back-of-House File Locations

• The Program Files folder contains an Aloha SupportReady folder.
• The Aloha SupportReady folder contains an Aloha Admin Service folder.
• The Aloha Admin Service folder contains the RAL executables, resource, and configuration data.
• RAL stores the configuration data in AlAdmSvr.xml in the Data folder.
• Installation logs are written to the %IBERDIR%\TMP folder on the RAL BOH server.
• AlohaServerLog_YYYYMMDD.txt (where YYYYMMDD is the system date of the information) con-

tains information about RAL clients connecting to the Aloha Adm service.
• AlohaUILog_YYYYMMDD.txt contains any errors detected by the Aloha Administrator user inter-

face.

RAL Front-of-House File Locations

• The C:\Program Files\Aloha SupportReady\AlohaAdm directory contains the RAL executables, 
logs, and configuration data.

• Log files are also located on terminals in the %Localdir%\Tmp folder, after RAL completes the 
initial configuration. The names for these files are in the format, DebRAL_YYYYMMDD.xx, in 
which the terminal ID number replaces the ‘xx’ component.

• AlhAdmin_YYYMMDD.txt contains RAL information related to terminal configurations on the 
date specified in the YYYYMMDD format.

RAL Install Log

RALInstallLog_yyyymmdd.txt is located in the same folder/location from which you execute RALIn-
stall.exe. This can be helpful in possible install issues.

QueryMachine Return Codes

Querymachine.dll is the file that does the initial check on install to determine if the terminal on which
you are installing RAL is a Radiant terminal. 

1: = "This is not a radiant machine"

2: = "This is a radiant machine, but the platform was not determined"

3: = "This is a P1550"

4: = "This is a p1510"

5: = "This is a 1210"

6: = "This is a 1220"

7: = "Error in library"

Special Environment Variables for RAL

RALWorkgroup — RAL automatically adds each terminal to a workgroup different from that of the
server. This is useful for BOH servers that belong to a domain, but terminals need to belong to a work-
group. The workgroup value is configurable. It can read the unit number from the Aloha.ini file by using
a value of %unitnumber%<text here>. For example, if the unit number is 15 and you want to set all
terminals in a workgroup called 15Aloha, set the value to %unitnumber%Aloha.

RALResetSite — When this variable is defined, RAL adds a button to the Site Configuration screen
called Reset Site. Use this feature when switching out databases. This is useful in lab environments
when testing. It can change out the entire RAL data xml to work from one database to another without
the need to reinstall or add/delete terminals.
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RAL Return Codes in Log Files

The RAL return codes are for debugging purposes. The list below explains what they mean.

Success = 0

RequestTypeInvalid = 1

NoStoreFound = 2

NoTerminalFound = 3

UDPIPAddressNotAvailable = 4

UDPIPRequestMultipleStores = 5

UDPIPRequestSingleStoreMultipleIP = 6

UDPIPRequestUserSelectedTerminalAlreadyInUse = 7

UDPIPRequestTerminalConfigurationSent = 8

UpdateTerminal = 9
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FAQ 
FAQ
Q) Can I install RAL on any computer?
A) You can install the Back-of-House RAL service and Terminal Configuration utility on any computer.
Earlier versions of the RAL POS Terminal installation launches only if it detects Radiant firmware during
installation. RAL version 14.1.x and later removes the hardware restriction and can be installed on any
terminal.

Q) If a terminal does not have the RAL application loaded on it, can I add it?
A) Yes, the RAL installation is relatively small and you can load it on a flash drive or copy across the
network. After you copy the RAL installation to a terminal, you can use a keyboard to launch the instal-
lation application from the Run command or Windows Explorer. You can also use the touch screen to
launch the installation process, without having to attach a keyboard.

Q) Where can we get the RAL software?
A) The RAL software is part of all base images installed on Radiant terminals. You can also download
RAL from the Aloha Update site. It is not installed on Radiant servers due to the requirement of Aloha
being installed.

Q) Is there a cost for RAL?
A) No, RAL is available as part of the Aloha Support Ready suite at no charge.

Q) Do I need to know the network settings of the store receiving the loaner or replacement
terminal?
A) No, RAL has the ability to connect over a sub-layer of the networking hierarchy that allows it to
broadcast requests for configuration to the RAL Aloha Admin service.

Q) What interaction from a store manager is needed after a terminal loaded with RAL arrives
on site?
A) The restaurant personnel must:

1. Place the terminal/kitchen device at its location, and connect power, network, and peripheral 
cables. 

2. Select which terminal to reload in the Site Configuration screen. 
3. Touch which terminal to reload on the FOH terminal, if more than one terminal is configured in 

the BOH RAL application and more than one terminal is marked for a reload.

If only one terminal is selected for reload, RAL automatically configures the new terminal with-
out any further intervention from a store manager.

Q) How long does RAL take to configure a terminal?
A) Depending on the network, it typically takes RAL about five minutes or less to configure, restart, and
copy the necessary files, before the Aloha floating logo appears on a terminal or Aloha Kitchen loads on
a kitchen device. 

Q) What is the best way to send a loaner or replacement terminal with RAL?
A) You should load RAL on the loaner or replacement terminal or kitchen device. The network settings
and computer name is not important, as RAL configures these settings automatically.

Q) Is RAL capable of staging a new system?
A) Yes, one of the benefits of RAL is its usefulness in many different scenarios. The staging personnel
just configure the Aloha file server and load the RAL Aloha Admin service and Terminal Configuration
utility. After you configure the environment settings for each terminal defined in Trm.dbf using RAL,
load the RAL Aloha Admin application on each POS terminal, if it is not part of the terminal image. RAL
on each terminal connects to the service and prompts the staging personnel for the store and terminal
number. In most cases, staging personnel can unpack a terminal, turn it on, and have the Aloha floating
logo appear without connecting a keyboard.
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Q) Will RAL work on a domain or workgroup?
A) RAL will work on both domain and workgroup network configurations. You must define the domain
credentials in the Set Domain Account Info function to allow a terminal to connect to a domain. RAL
uses this information to connect the Aloha BOH file server to the domain, and to configure the terminals
with the proper network settings for connection within the domain. Account information that is incor-
rect, has minimal privileges, or missing can prevent RAL from configuring the terminals and connecting
to the Aloha BOH file server.

Q) Can I configure a less vital terminal to replace a critical Aloha terminal?
A) Yes, you can use an existing terminal that does not currently perform critical functions to replace
Aloha terminals that run kitchen printers or perform other critical functions in the restaurant. This pro-
cess reduces the risk of running without a critical Aloha component over a busy weekend.

To exchange a terminal:

1. Click Exchange Terminals on the Site Configuration screen.
2. Select the terminals to exchange from the drop-down lists.
3. Disconnect the functioning terminal from its current location and move it to the critical loca-

tion, where the printer runs are located.
4. After connecting the terminal appropriately, restart the terminal. The RAL Aloha Admin appli-

cation determines the terminals available for configuration.
5. Select the appropriate critical terminal number and RAL reconfigures the terminal with the 

appropriate settings for this terminal.

Q) Why does the terminal return ‘No network enabled NIC detected?’
A) If you set the NIC on the terminal to use DHCP, but the terminal fails to find a DHCP server, Windows
assigns a default fixed IP address to the terminal that begins with 169. If RAL detects an IP address
beginning with 169, it fails to configure the terminal. 

To solve this problem:

1. Verify the network cable is plugged in to the NIC.
2. Change the IP address to one that begins with a different octet. Consider changing the IP 

address to the NCR default value, 192.168.0.2, or similar. 

Q) What should I check if Aloha does not run after RAL completes its process?
A) AlhAdmin_YYYYMMDD.txt/Debralyyyymmdd.nn contains important information regarding the status
of the RAL configuration. Normal Aloha troubleshooting, like debouts, may also assist in determining
the problem. Generally, if RAL completes and the FOH starts, this is not a RAL issue, but rather Aloha
itself. Check the debout and RKS site for a resolution.

Q) Can I turn on all of my terminals at one time, when configuring RAL for the first time, if
the image for each terminal is the same?
A) Yes.

Q) When I use the Refresh button in RAL, nothing happens on the FOH. Why is that?
A) The Refresh button in RAL is only to refresh the Site Configuration screen. It does not function to
refresh the FOH terminals. 

Q) Does RAL have to reconfigure the entire terminal every time I make a change in the Ter-
minal Configuration screen?
A) RAL no longer reconfigures the terminal unless the following are changed: Aloha Path, Termstr, IP
Address, Server name or there is an upgrade on the terminal to the later server version in which case
RAL does a full reconfiguration. If you change other variables, the terminal logs off and back on, then
RAL starts the FOH in what is called a partial reconfiguration.
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FAQ 
Q) Can I customize the user interface with different languages for the field labels?
A) Yes, you can edit Strings.txt, found in \Program Files\Aloha SupportReady\Aloha Admin Ser-
vice\Resources on the BOH file server to change the labels to a different language, then recompile
Strings.resources using the ResGen.exe found in the same folder. See “Translating RAL” on page 34.

Q) Can I port my gateway and DNS entries from the server to the terminals?
A) Yes, RAL adds any entries in the gateway and DNS fields on the server to the terminal, if you use the
<add key="SetGatewayInfo" value="1" /> in AlhAdmin.exe.config.

Q) How does RAL work with Syncinclusion?
A) With RAL version 2.3.2.4 and greater, RAL checks for the existence of the following files in the bin on
the file server:

• Iber.exe or Iberqs.exe (depending on if it is TS or QS)
• RFSClts.dll
• Iberstr.dll
• Iberrq.dll 
• Syncinclusionlist.cfg
• RFSClt8s.dll

If RAL finds these files, it copies only these six files to the Bin folder on the terminal as part of the ter-
minal configuration. Iber(QS).exe handles the rest of the files once it starts.
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Troubleshooting RAL
This section discusses RAL errors and issues you may encounter and how to troubleshoot these issues.

RAL outputs debugging logs on both the server and terminals. Be sure to check these first for informa-
tion. The following tables show the location and names of the debugging files:

TERMINAL:

SERVER:

Installing RAL on the terminal does not give the POS terminal option, only the Back 
of House file server. 

This means that the installer program cannot find Radiant firmware on the terminal. This occurs if you
try to install on a non-Radiant terminal. RAL will not work on these terminal types.

Locating the Debouts for Troubleshooting RAL with Kitchen Devices

Like the POS terminals, RAL creates a DebRALyyyymmdd.nn, where nn is the terminal ID number. This
file is located in the AlohaKitchen\TMP folder on the kitchen device.

Starting the Aloha Admin Service User Interface returns the error pop up “Error 
setting up NIC. Please restart the Aloha Admin Service.”

This error occurs when the AlAdmSvr service is not started. To correct, simply start the service. In all
versions of RAL, the service is set to start automatically when Windows starts. We have found on some
sites, for reasons unknown, the service attempts to start but if the prerequisite service (WMI) has not
started yet, it cannot start. This is addressed in version 2.1.2.2, and later. In these versions, RAL
checks and starts the service when you open the Aloha Admin Service user interface, if the service did
not start on reboot automatically, similar to Aloha Manager.

“Please Select a Store/ Terminal which you wish to configure a terminal” appears.

In RAL versions 1.1.3.225 and lower if you do not select the store from the drop-down list and select
the Configure Terminal button, you receive this error. Simply select the store to use from the drop-down
list.

Terminals no longer appear in the Aloha Admin Service user interface.

This will only be an issue in version 1.1.3.225 and lower. By default when we load up the user interface,
we do not have a store selected, thus no terminals will show up in the Site Configuration screen. To fix
this, simply select the store from the drop down box. This has been changed in versions beyond
1.1.3.225 in that we no longer use the store drop down box, we now use the default store of ID 1.

Location File

C:\Program Files\Aloha SupportReady\AlohaAdm folder AlhAdmin_yyyymmdd.txt
\Aloha\TMP folder DebRAL_yyyymmdd.xx, where xx is the 

terminal number

Location File

\Aloha\TMP folder AlohaServerLog_yyyymmdd.txt and Alo-
haUILog_yyyymmdd.txt
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Troubleshooting RAL 
RAL appears to have completed the configuration of a terminal, but when it tries to 
load Aloha, you receive an error message stating that Iber(qs).exe could not be 
found.

In older versions of RAL, 1.1.3.225 and lower, if you created a new user account on the terminal for use
as the auto-login account, but did not create that same user account with administrator permissions on
the file server, you have a permissions issue. To fix this, create the same user account on the Aloha
BOH file server with administrator rights. In new versions of RAL, you can only select the account with
which to log on to the FOH that is already created on the BOH file server with administrator rights. If
the account is not in the administrator group on the Aloha BOH file server, then it does not appear in
the drop-down list in the RAL BOH Configuration screen, and the terminal cannot use it.

Another cause could be that Use Simple File sharing is enabled on the server. Clear this option to cor-
rect.

RAL is stuck on the Requesting Configuration screen. 

RAL requires that if you enable the firewall on either the server, terminal, or both, you configure the fol-
lowing exceptions to allow communication.

• UDP ports 11000, 11001, and 11002.
• If you use multiple RAL servers on a network, open the UDP ports that correspond with server 

and terminals for the site. See “Running More Than One RAL Service on a Network” on page 32.
• IP address 224.168.100.25 for UDP calls.

When loading the user interface, the error message “The NUMTERMS variable 
(NUMTERMS=x) does not match the number of terminals (x) configured in Aloha 
Manager. Please adjust either the NUMTERMS value or number of order entry 
terminals before continuing” appears. 

Change the NUMTERMS variable on the Aloha BOH file server to match the number of order entry ter-
minals defined in Aloha Manager. 

In the terminal configuration screen, ‘Enable OrderPoint’ is not available. 

Order Point must be installed on the BOH file server to activate this option, and RSSEngine.exe must
reside in the %Iberdir%\BIN folder.

Cannot install RAL on the BOH file server without fatal exception errors.

RAL requires that you install Aloha since it must access Trm.dbf. Another cause could be a corrupt or
improper syntax in RALInstall.exe.config.

On capacitive touch screen terminals, RAL gets stuck at the Requesting 
Configuration screen. 

Upgrade to version 1.1.3.224, or later, to eliminate this issue. In earlier versions of RAL, when there
were items in the startup group on the terminal, a prompt to select yes to continue with the terminal
configuration would appear; however, the message appeared from behind the main RAL screen. You
had to double-click the taskbar to get the second instance of the program to come to the forefront so
you could respond to the message.

Terminal is stuck “Waiting for system configuration to complete.”

• Confirm the user account each terminal uses to log in is included in the Bootdrv share proper-
ties on the Aloha BOH file server.

• Confirm there is an OK file in the \Data folder.
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You install the RAL server component on a FOH/BOH site running Windows XPe, 
but receive an error initializing NIC when you try to load it.

Microsoft.Jet.Oledb is not properly installed. You can install the newest version available from Fox Pro at
http://www.microsoft.com/downloads/details.aspx?FamilyId=E1A87D8F-2D58-491F-A0FA-
95A3289C5FD4&displaylang=en.

You will then have to change the line in Program Files\Aloha SupportReady\Aloha Admin Ser-
vice\AlAdmSvr.exe.config from <DBFConnectionProvider>Microsoft.Jet.OLEDB.4.0</DBFConnection-
Provider> to <DBFConnectionProvider>VFPOLEDB.1</DBFConnectionProvider>.

RAL cannot create a new user account on the FOH terminal.

The terminal image is missing Net.exe and Net1.exe, which RAL needs to create a new user account on
the terminal. Add these two files to the terminal, then reload RAL. 

RAL fails on the FOH terminal with the error "The root element is missing."

Rename or delete C:\Program Files\Aloha SupportReady\AlohaAdm\AlhAdmin.xml on the failed termi-
nal then copy AlhAdmin.xml from a working terminal to the failing terminal. Alternatively you can rein-
stall RAL to fix this. This is due to a blank or corrupt xml file.

The user account created for EDC/RFS service or the terminal does not appear in 
the drop down list. 

Verify the user account is in the Administrator group. By default all new Windows user accounts appear
in the user group only. You must add them to the Administrator group.

You receive the following message in the log file when trying to load the terminals: 
Throwing unhandled exception: A message sent on a datagram socket was larger 
than the internal message buffer or some other network limit, or the buffer used to 
receive a datagram into was smaller than the datagram itself.

Open AlhAdmin.exe.config on the terminal and AlAdmSvr.exe.config on the Aloha BOH file server and
edit the key <add key="SizeOfBuffer" value="" />. The default value is 8192. We recommend you dou-
ble this value, save, and exit. This can occur with a large number of terminals configured in the user
interface, usually 16 or more.

When trying to open the user interface, you receive the following message: "User 
Interface could not get NIC information. Exception logged in the log file. Please 
verify." The entry in AlohaUILog_yyyymmdd.txt is as follows:
User Interface could not get NIC information. Exception : Object reference not set to an 
instance of an object. Stack: at Radiant.AlohaPOS.RadiantAutoLoader.ALStartUp.Main()

Open AlAdSrUI.exe.config and locate the following key: <add key="CheckForConnectedNIC" value="1"
/>. Set the value to 0. Save and exit. 

When trying to install or uninstall RAL, you receive an error 1720; “There is a 
problem with this Windows Installer Package. A script required for this install to 
complete could not be run. Contact your support personnel or package vendor.”

You could have a corrupt WMI repository, you need to upgrade the Windows Installer, or you need to
restart the Windows Installer service.
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Troubleshooting RAL 
Try the following to determine which one is causing the issue.

1. Stop and restart the Windows Installer service. Try to reinstall or uninstall RAL.
2. If error persists, upgrade the Windows Installer from Microsoft. Once you upgrade, try to rein-

stall or uninstall RAL. 
3. If problem persists, run the following:

Windows XP and Windows Vista

a. Click Start > Run, and type CMD.exe.

b. Type net stop winmgmt and press Enter.
c. Using Windows Explorer, rename the folder %windir%\System32\Wbem\Repository. 
d. For example, %windir%\System32\Wbem\Repository_bad. %windir% represents the path 

to the Windows directory, which is typically C:\Windows.
e. Switch to the Command Prompt window, type net start winmgmt, and press Enter.
f. Type exit.

The NIC is set to LANA 0 but each time you load the user interface a message 
appears stating that LANA is not set to 0. Selecting Change does not fix the 
problem, nor does the Skip button.

This is caused by the binding order in a dual NIC system, and the NIC being used by RAL is not at the
top of the binding order list. 

To fix this issue:

1. Select Control Panel > Network and Internet > Network Connections > Advanced > 
Advanced Settings > Adapters and Bindings tab. 

2. Select the NIC you are using for RAL and verify that it is the first one in the list. 

If not, select it and use the Up arrow button to move it to the first one in the list.

In Windows Vista and later, you need to open an elevated Command Prompt window. 
To do so, click Start > All Programs > Accessories. Right-click Command Prompt, and 
select ‘Run as administrator,’ from the menu that appears.
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RAL Password and Permissions Corrective Action 
Procedure
RAL is a powerful tool that helps to maintain some of the PCI standards that have been established for
computers on your network. It features the ability to automatically change the passwords of FOH user
accounts at specified time intervals, prevents local login of accounts that do not require the ability to
log in locally, and it removes the need for site personnel and support staff to be aware of the passwords
being used by these accounts.

These features tend to contradict our traditional views of Windows user management. They also signifi-
cantly affect the methodology we apply when attempting to resolve FOH network configuration issues
as they relate to Windows user accounts. This section discusses the standard procedure for resolving
any issue relating to user, password, or permissions issues involving FOH terminal user accounts. One
of the strengths of RAL from a support perspective is that RAL manages the vast majority of potential
problems with a single procedure.

This section discusses the procedures you should perform if you are experiencing any of the following
pertaining to the FOH using RAL v14.1, or later:

• Permission issues
• User account issues 
• Password issues

To resolve these issues:

Step 1: Reboot all FOH terminals to resolve the issue.

After you reboot the terminals, check to see if the problem still exists. If it does, proceed with 
the additional steps. If the problem is corrected, the issue is resolved.

Step 2: Enable user validation in the RAL user interface configuration.

a. On the Aloha BOH file server, close the RAL user interface and stop the AlAdmSvr ser-
vice.

When a site is using RAL v14.1, and later, there is no reason to manually change the 
terminal user account passwords on any computer (FOH or BOH) unless you are per-
forming this procedure. Making manual changes to the passwords on any FOH ter-
minal user account causes the FOH login to fail. Depending on the timing of the 
change, it can take hours or days for the failure to occur.

RAL updates the passwords on the Aloha BOH file server at exactly the number of days speci-
fied in the RAL configuration; however, the FOH terminals do not update their RAL configura-
tions until after they are rebooted. In the rare situation that a FOH terminal or the BOH server 
is rebooted after RAL has changed the passwords, but before the terminals are refreshed or 
EOD has processed, it is possible for password conflicts to occur on the FOH or between the 
FOH and the BOOTDRV share on the server. Rebooting all terminals will allow them to reload 
and correct this situation.

It is likely while the password conflicts exist, the terminals lock the terminal user accounts on 
the BOH. To correct this, open the Computer Management console, locate, and double-click 
the terminal user account and clear Account is locked out for each terminal user account. 
Because this may occur multiple times during the correction process, it is advised that you 
power down all terminals, during the corrective actions, so they do not attempt to connect to 
the BOOTDRV share.
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Troubleshooting RAL 
b. Access C:\Program Files\Aloha SupportReady\Aloha Admin Service.
c. Open AlAdSrUI.exe.config using Notepad.
d. On the tool bar, select Edit > Find…, type ValidateUser in ‘Find what,’ and click Find 

Next.
e. Change the current value from 0 to 1.

f. Click File > Save.
g. Close Notepad.

Step 3: Remove the ‘Deny log on locally policy’ from the FOH user accounts defined on the
BOH:

a. Click Start > Run.
b. Type gpedit.msc.
c. Click OK.
d. Access Computer Configuration > Windows Settings > Security Settings > Local 

Policies > User Rights Assignment.
e. In the pane on the right, locate and double-click Deny log on locally.
f. Select each terminal user account and click Remove.
g. Click Apply.
h. Click OK.

Step 4: Change the FOH user account passwords to a known value on the BOH:

a. On the BOH computer, click Start > Run.
b. Type compmgmt.msc.
c. Click OK.
d. Access Computer Management > System Tools > Local Users and Groups > Users.
e. In the pane on the right, right-click the first terminal user and select Set Password.
f. Click Proceed.
g. Type a new password.
h. Confirm the new password.
i. Click OK.
j. Define a new password for all terminal users on the BOH.
k. Close the Computer Management Console.

Step 5: Update the FOH user accounts and passwords in the RAL user interface:

a. Open the RAL user interface and type the newly created passwords in the configuration of 
each terminal.

b. Start the AlAdmSvr Service on the BOH.
c. Open the RAL user interface.
d. Select the first terminal in the list.
e. Click Configure.
f. In ‘Default User Information’ of the Terminal Configuration screen, ensure the correct user 

account for the terminal is selected.
g. Enter the new password in ‘Password.’
h. Click Save.

The full text of this line in the file should read like the line below after the change has been
made:

<add key="ValidateUser" value="1" />
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i. Repeat this procedure for all remaining terminals.
j. Close the RAL user interface.

Step 6: Re-enable the ‘Deny log on locally’ policy on the FOH accounts:

a. Click Start > Run.
b. Type gpedit.msc.
c. Click OK.
d. Access Computer Configuration > Windows Settings > Security Settings > Local 

Policies > User Rights Assignment.
e. In the pane on the right, locate and double-click Deny log on locally.
f. Click Add User or Group.
g. Enter the user account name for each terminal, separated by semicolons (;).
h. Click Check Names.
i. Click OK.
j. Verify the user account for each terminal appears in the Local Security Setting list.
k. Click OK.
l. Close the Group Policy editor.

Step 7: Disable user validation in the RAL user interface configuration:

a. On the BOH computer, open the AlAdSrUI.exe.config file using Notepad.
b. On the tool bar, select Edit > Find..., type ValidateUser in ‘Find what,’ and click Find 

Next.
c. Change the value from 1 to 0.
d. Click File > Save.
e. Close Notepad.

Step 8: Reboot the FOH terminals to allow RAL reload:

Any reboot method will work. Having the site press the power button on each of the terminals 
to power them down, then having them turn them back on is the recommended procedure in 
this case.

Because you have re-enabled the user validation, RAL confirms the user name and password 
are correct before saving the configuration changes for each terminal. If you receive the mes-
sage “The account does not appear to be set up correctly,” this is most likely an indication that 
the password you entered does not match the password you set for the account using Com-
puter Management in the previous step. Re-enter the password; however, if it continues to fail 
go back to the Computer Management console and set the password for the failing terminal 
user account again.
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Troubleshooting RAL 
Feature History

Supported Versions Description

14.1.4.0 Exchange Terminals button now active in the user interface without 
the need for the system environment variable. 

14.1.4.0 Opened the IP address and subnet mask fields to allow for segmented net-
works.

14.1.4.0 Added DNS1, DNS2, and gateway entry fields in the BOH Config 
screen. 

14.1.4.0 Added support for Aloha Kitchen configuration.
NCR Aloha RAL v14.1 Page 47



Page 48 NCR Aloha RAL v14.1


	NCR Aloha RAL v14.1
	Table of Contents
	About NCR Aloha RAL
	Hardware and Software Requirements
	Creating Windows User Accounts
	Implementing NCR Aloha RAL
	Implementing RAL on the BOH File Server
	Installing RAL on the BOH File Server
	Using RAL for Site Configuration
	Accessing RAL from the System Tray
	Configuring RAL Settings for FOH
	Configuring Terminals
	Configuring Aloha Kitchen Devices in RAL
	Copying Settings from One Terminal to Another
	Restricting User Account Login on the BOH
	Installing RAL on a FOH Terminal or Kitchen Device
	Using RAL on a FOH Terminal to Complete the Configuration
	Selecting the Network Interface Card on the FOH
	Selecting the Device Type
	Discussing Using Separate User Accounts on a Terminal

	Upgrading RAL
	Using Custom Configurations with RAL
	Using RAL on a FOH/BOH Computer
	Changing the Administrator Password Length with RAL
	Installing RAL Using a Command Line
	Running More Than One RAL Service on a Network
	Translating RAL

	General Info
	FAQ
	Troubleshooting RAL
	RAL Password and Permissions Corrective Action Procedure



